Keyboard Equivalents for Commands in Paint Cutter™

Command-A Select All Hccessorg Pak ITM

Command-B Copy to Scrapbook

Command-C Copy to Clipboard

Featuring Paint Cutter ™

............................................................................

Command-0 Open

Command-P Show Page

Command-Q Quit

Command-R Set Origin

Command-S Select Screen

Command-T Save Startup

Command-V Paste

Command-X Cul !

Command-Z Undo

Special Key Uses
Space Bar Hand tool

Tilde Undo ( ~
! Silicon Beach Software, Inc.
P.0. Bor 261430

* San Diego, California 92126
(619) 695-6956

Backspace Clear
Shift Constrain

Tab Change cursor 1o cross

Option Cepy selection into document

Command-Option Make multiple copies of selection

L Lock/unlock the coordinates window on the screen
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WARRANTY AND DISCLAIMER

Sllicen Beach Scftware, Inc, warrants the disk 1o be frae of defects for 80 days from the
purchasa date. M the disk is found 10 be defsctive In this 90 day pericd, return it 1o
Sikoon Boach Software, Inc. for a free replacement. Afer 80 days, return It with $5.00
lor @ replacement. Il you erase the disk yoursell before having made a backup and
nead a replacamant, retumn tha orlgnal with $5.00 for a replacament. To obtain this
warranty, you must send In the regisirabion card,
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SOME STATES, THE ABOVE EXCLUSION MAY NOT APPLY TO YOU, THIS
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Accessory Pak 1™

Introduction

Accassory Pak 1 brirgs you a set ol 100's that make it easior 1o work with your
Macintosh. This manual beging with an evandew of these 10ols and their features.

Paint Cutler™

Pain Cutter is a stand-alone program that lets you work with MacPainl decuments,

I adds a number of features that wil improve your productivity as you create graphics
with your Mac. Palnt Cutter will enable you 10 ¢o the foliowing:

+ Quickly and easily cut, copy of pasta sefaclions of any 20, up 1o eéntire & x
10" piciwes, batwean MacPaint dosuments of 1o other applcations such as
MacWirite, and MacDraw.

+ Copy drectly 10 1he Scrapbock without apaning the Scrapbook desk
ACCASSO0Y.

« Pazte MacDraw piclures of any £ze Into a MacPaint document, reduced
proportionately to fitinto MacPaint's 8° x 10° page.

« Create your own custom startup screans which wil appear instead of the
tamiiar "Walcoma 1o Macintosh® screen,

« Usa he Coordinates feature 1o read in inches, canlimetars, of pixels, the
oxaat location of the cursor on the screen and 10 measure elemants in your
drawirgs,

« Printa page or just a selecton from a docurnent in normal, high qualiy, o
50% reducllon modes.

«  Aulo-scroll ymllo salacting to make largerthan-soroon selecions,

v Move, inven, or fip your selection, regardass of its size and do 80 degree
rotations of selaclicns up 1o 8° tal.

« Ona 512K Mac, open &s many as four MacPaint documents at one time

and quickly fip between them. A seleclion made in ona cocument can be
vansferred iImmediately 1o another, without cepying and pasting,

© Soon Beach Softwase, Inc. Accassory PRk 1 Pags 2

Rulers

Rulers Is a desk accessory that puls a set of rulers around the MacPaim drawing
window. Active tick marks in the rulers rack tha cursor and you draw objects on
the screen 10 spectied sizes. You can measure in inches, can , OF pixals,

Screen Saver
Screen Saver is a ulility program that will darken your screen after you leave your
Maa idle for a specified length of time. This will save your screan from image bum-in

mwmmmmymuac is left on without being used for prolonged periods of

Coordinates

This dask accessory will give you the cocrdinates of the cursor ininches,
centimeters, or pixels while you ara In an application program.

QuickEject
Ths dask accessory will eject all floppy disks and restart the Macintosh.

Silicon Beach Font
Now you can add another fart 1o use with applicalicns that let you charge forts,

Backup Before You Begin

Bedora you stan working with Accessory Pak 1, backup the disk. M uging one drive,
use the backup ulility peovided on your Apple Systlem dis’. ¥ using two drives, start the
Maa with Accesscey Pak 1, inserl a blank disketle (in¥aizing it il nacessary) into the
sacond drive, and drag the icon of the Accessory Pak 1 disk to the icon of the blank
disk, Accassory Pak 115 not copy protacted, $0 you can copy the antire disk or any
items individually,

How to Use Paint Cutter

You loved MacPalnt, now you'ra going 1o lave Palnt Cutter. For your convenanca,
Panl Cutter crealss no temporary dis’ fllas and it gives you quick access with tha hand

© Sion Beach Sotware, ke Acoossory Paik 1 Page 3




ool 10 any pan of the picture, even on & 123K Mac. Excapt where noted, Painl Cutter
features work the ame in ary mamory confguration: 128K, 512K, Macintash XL, ard
with Switcher or a RAM disk. Please ee the seclion Memory Configuration and
Low Memory Limitatlons for furibar infermation. XL users take nota-Paint Cutter
uges tha full scraen to lat you viaw ovar half a MacPaint decumant at oncal

You'll find Paint Cutter easy 10 use sinca many functions work tha same as
MacPanl. Thase basic simianteas includa: making and maving a seleclicn, scrolling
1ha picture with the hand, and most of the File and EJit menu ilems. Many ol thesa
functicns have tesn enhanced, For example, a selection can be moved 1o any part of
1ha documant since scroling with the hand 1col doasn't paste tha sefection doan. The
rast of this section will focus on descriding tha Impraved funclions and other leaturas
uniqua to Paint Culter.

Starting Paint Cutter

Insort the Accessery Pak 1 cisk into your crive and doubie-click the Fainl Cutler
Icon, Hard disk users can move Paint Cutter to a valume for more elliciant eperation.

Scrolling the Document

Prassing 1ha Space bar wil give yeu the hand tool with wivch you can drag the
8" x 10" piclura around on tha screen. Unlike MacPaint, Painl Cuttee's hand tod! gives
you the freedem to mova the plcture around with the selection stil active.

Making and Moving Selections

You can drag the cross cursor 10 salact a part of your drawing for cutting or cogying,
or far meving from one place to another. As you know, MacPaint imits a selection %
the siza of the MacPaint windaw. Paint Cultar provides you with several techriques for
sefacting larga porions of your drawings.

1. As you creats a selection rectangle and extend il 1o the edga of the screan,
Panl Cutter will automaticaly scroll yaur drawing 10 includa new matadial
césorenn.

2. Use the Salect Scraen command from the Edit menu 1o selact the antre
Paint Cutter screen, This screen is larger than MacPant's drawing

windaw.
3. Use tha Select All command frem the Edil menu 10 seloct the ontive 8° x
10" drawing.
© Sicon Boach Sohwaro, e Aooassoy Pax Page 4

A salection can be dragged anywhera in the documeant and mevement Is not
restricted Lo the ecrean. Using the hand 100! 10 scroll the picture won't cause the
selection o be pasted dawn, In facl, Paimt Culter dossn't paste your selaction down
until you click outside of It. A special techniqua for pazting down salections, especialy

large ¢nas, is 10 hold down the Tab key 1o get the cross cursce, and click insica the
selgcton,

Note: Yeu can drag a selecton almost completely off the odge of the pags. Althaugh
this allows you great freacom in posioning the selecticn on the page, bs awara that
any perion of the salaclion that i off the page whan you paste it down will ba lost, You
canuse Undo or Reven, as appropeiate, 0 recover Irom mistakes. Be sure 10 save
your wark frequanty to pravent the loss of vauabla dalal

Note: Imagine thera is an active selection but you cant ses it. This slituation can
actualy occur whan clicking on tha document creates a very tiny unnoticad selaclion or
whan the selecton has bean screlled cul of view, In aither casa, you will find that
strange 1hings may happen, espacially when Paste seems 10 have no eflect, To check
for this condition look at the Save Selecton tam in the File Meru. If it's not grayed
then you know theve is a selection actva,

Constraln

The Shift key constraing scrolling 1he page with 1ha hand and draggihg of a
galaclion 1o caly horizontal or verlical movements. Make sure Shift is prezsad bedore
you drag. In Show Paga moda, Shifl constrains the mavernent of tha rectang'e that
reprasents the Palnt Cutter viewing window. It @50 constralng the movemants of tha
pictura itsell, Untka MacPainl, Shift will also constrain 1ha selection rectangle, as It s
baeing grawn, to & squara,

Single and Multiple Coples

As in MacPalnt, haiding the Cption key while dicking In or dragging a selection
craatas a single copy of the salecticn. Pressing bath Command and Option keys while
cragging the selection will make mulliple coples, In addition yeu can constrain tha

mulliple copias to either the verical or horzontal axes with the Sh#t key. Please see
Memory Conflguration and Low Memory Limitations for mere detalls,

Translerring Dala Between MacPalnt Documents

512K Mac: Pant Cutier makes it easy 1o copy and paste betwesn several MasPar
documents, You can cpen as many as four MacPalm documants with Painl Cutter and
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chaosa the ana you wanl 1o view from the Piclures menu, where tha names of &l the
open documants are fsted. With the cross cursar, Craw a seleciion rectangle around
the area you want 1o mowve 1o ancther document. Whan you choose the destinaton
document frem the Piclures many, the salaction wil appaar on the destination
dosumen, ready 10 move into place.

Heve's an axampla of 1he tansler process. Suppase you wanl 1o move several
slemants from ci#erent documents Into one cocumant, Folow thess staps:

1, Choose Open fom tha Fie menu 1o gat a direciory of MacPalnt documants.
Dounle-click 1ha MacPaint decumant that contalns tha mataral you want to
use,

2. Repeal stap 2 % open &l e other MacPaint cocuments that contain
material you naed,

9. Choose the document you want 1o werk win from the Pictures manu 1o
being it into view.

Figuwre 1: Tha Plslure menu.

© Sioon Baach Sohwar, be. Acoaasory Pak 1 Pege &

4. Choosa the area yeu ward with the seaction reclangle.

5, Choosa the pleture you want 10 put the selection on from the Plolures

rr;?rtm. This displays the selectad picture with tha selection sting on top
o

& e (o LELERTE Piclures by

Qaguweads

"v w/ Azoleasi-Eey,

Magesil
e with e

Figure 2: Selection on Unitlad.

€. Drag 1ha selacton nto pesition on the page and ¢ick outslde the galaclion
o paste il down.

7 Rg)eal staps 4 through 6 until you have all the pieces pasted into your
picture.

£. Use Save As from tha Fle maenuy o save the modifled pictura with a new
name,

In this way you can quickly meva pleces from many documants 10 buld new piclures

123K Mac: Wilh a 126K Mac, you can enly have cne document open atatima, To

© Siloon Basch Sotwans nc, Acceszory Pak A




mave data from ane MacPalnt document to another, use the Clipboard and Scrapbook.
Tha advantage of Paint Cutter is that it wil let you copy a selection of any slze, upiloa
full MacPaint picturs, into the Clipboard or Scrapbook. Then you can open another
documant and paste the selection inlo . Paint Cutter wil save you a great deal of ima
moning pictures from ene document to ancther.

Select

Transferring Data Betwean Palnt Culter and other Applications

fezhapo
You can use Paint Cutter 1o mave small selections, 1ull screans, or entire MacPaint Smaath
pictures from one application to ancthar with the Copy to Cliptoard and Copy 10 Eazmoath
Scrapbook commands from the Edit menu, Please note that not all large selections Boond Loeners

wit 4t inta the Clipboard or inta one Scrapbook fom, and you may have 1o use two
smaller salacticns. This problem may arisa with pictures that don't have large areas of
20id biack or white, such as digtzed images. Thay don't get compressed very wel
and may not be under the 32K maximum for & piclure in the Clipboard. Paint Cutter
will inform you If this siluaticn ever cccurs,

MacWrite: At imas you will want 1o meve larga pictures into MacWrits. Paint Cutter s Figure 3: Selecting a large pictura from MacOraw.

just tha toal for deing this, Selact the MacPaint document you want o mave, open i

into Palnt Cutter, make your selection, quit Paint Cutter, and paste the picture into your r

MacWrite document. & Flile Ecit Dptioas Pletures b

If the piclwe is wider than Mac\Write's margins, you'l see that tha picture pasted
irto MacWirke looks distorted. MacWrite reduces the width of the picture 1o .
accommodate it wihin the margins. If you want your plcture to paste inlo MacWrite
full-width, you must open up MacWrita's marging 1o sight inches. You can da this by
dragging the MacWrite windaw 10 1ha lof of tha Mac screéen aboul 1172 inches.
Enlarge e MacWrite window with the size box at the lower lelt comer until you 500 the §
elght inch mark. Move the right margin indicator 1o the eight inch mark and pasta in
your pictura. It wil not be distorted. Now you can insedt a now ruler with your standard
taxt margins 56t 50 you can continua entering yeur texl.

MacDraw: If you want 10 move a MacDraw picture larger than 8° x 107 info Palm — : ——

Cutter, se'ect the entre picture from MacDraw with the Select Al command in the Eait .

menu, as shown in Figue 3. ? — O e - —ll -
Cheosa Copy, quit MacDraw, and cpan Paint Cutter. Choasa Naw from the File *‘j’r‘" st kA

meny 10 get & blank Paint Cutter page, and ¢choose Pasta from the File menu. Paint p——— ; el : -

Cuttar will autemasically reduca the picture proportonately to fit into an 8° x 10° page, 5l o .

as ehown In Figure 4. < e R

Figure 4; Tha MacOraw picture in Paint Cuttar.
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Hiding the Menu Bar

You can romave the manu bar from view by double-clcking anyahere on tha
piclura, or by chaosing Hida Merws frern the Opticns many, Double-clicking agaln will
nring tha menus back. All Command key equivalants for meny items will work with the
manus Ndden (sea the Quick Reference of Keyboard Equivalents).

To prevent pazting down an active selgction when you want to double-click 10 show
or hide the menus, deuble-chek inside tha selacton or 1irst put vp the hand tocl by
pressing the Space bar then doubla-click.

Creating Starlup Screans

Palnt Cuttar lats you create yoeur own Macinosh startup screens, \Whan you fhst
{ur on your Mac, your oan custome-designed screen will ba dspiayed as e Mac
stants instaad of 1ha "Walcome %o Macintosh® screen.

Begn by using MacPalnt 1o design your stariup screen. Remember, & startup
screenis 512 x 342 pixels, the size of tha Mac screen, and is larger than MacPaial's
drawing window, Save the decument and open Palrt Cutter, Hide tha menus and use
the hand 100! 10 mave the page 5o that the upper left coener of your stanup plclure ks in
the upper lett comer of 1ha screen. To save your starup screen press Command-T or
bring back the marus and salect Save Startup from the Fia manu. ¥ the menus were
vislble, the menu bar will autematcaly be hiddan and you will see the dialog box
ghown In Figure 5. Wih a Macirtosh XL, the part of the drawing that is not par of the
slariup screan will ba temparariy blacked oul, framing your slarlup scraen.

Sovd slartup screen as: | agplicaticas
S'.ullup\l ;;HI, : ] (E]

[ Sove |

[ Ceacer ) [ Drive |}

Figura 5. The Save Startup Didlog box.

Tha nama of the fle defauts 10 *StadupSaesn™. For your scroan 50 coma up as the
startup screen, it Must have tis file namae, otheraise the slandard screen wil be
displayed. Remamber, the disk you sava this fila e must contain a System Ya so 1
can start 1he Mac. 4

Starlup screans thal & nol to ba dsplayed can bo saved with names such as
StarupScreen2. In tis way, you ¢an s10re several startup screens on ong disk.

© Skon Bagch Sohwarg, o Aczassaoey Pkl Piga ‘0

Vinichewer is called *StartupScreen® will ba the actve one on starlup. Later, you can
cepy Ihase slartup scroans 10 any disk you want.

To taka a look al axisting starlup acreans, chaosa Open Startup from the File merw.
This Is Just tka Opan for MacPaint documants axcept that the flles displayed wil be
starlup screans only, Starlup screens aren't saved as MacPalnt documerts, 50 you
can't open them with MacPanl. I you want to wark on your starlup sereens with
MacPalnt's tools, choose Save As whon a stantup screen is opan in Paint Cutter and
save il under a dfferont name, This saves your stanup screen as a MacPaint
cocument which can then ba edited with MacPaial's toals and later savad as & starup
scroen again with Save Startup in Paint Cutter,

Printing from Palnt Cutler

Whan you uss the Print commard fromn the File menu, withoul High Quatty or 80%
Aeduction selected, youll gl & printout of your cocument &3 i you were printing from
MacPaint with the Print Draf command, Chacking High Quality in tha Fie manu and
salacling Prind will give you a prinlcul simiar 1o MacPaint's Print Final command.

Paird Cutter oMters two printing laalures nol available wih MacPalnt  After making a
se'aclion, choose Print Sedaclien from the Fila menu % peint anly what you outined
with tha selaclion raclangle. You can also check 50% Reducton In tha Fila meru to
peint either your selection or the entire document hall-size, High Cuality and 50%
Reduction won' wark at the same tima,

Whan yau print out a documant or selection, the printer normally finlshes by
advancing 1ha papar 10 the naxi shaet. You can suppress INs paper fasd by helding

cdown the Command key whie choasing Print or Print Salaclion frem the File menu.

Coordinates

Show Coordinates from tha Opticns many provides & small window with two pairs
ol numbers that represent the curser's posiion. The top pair pves the paslion of the
curser on the screen. The bettam par is the position on tha §° x 10" document. The
firat number in aach pair is 1ha harizontal position while the sacond & tha vertical. You
may seledt the units of measuwrement from the Options menu by ehacking Inchas,
Centmetars, or Pixels,

Tha Coordinates window normally foliows tha cursor around on the screan bul can
be locked down in Iha pasition of your cheice by pressing the L key. To uniosk, press L
again. For measuring inside an aclive selection, whare the cursor is normally an
arrow, pross tha Tab key 1o get the cross cursor.

You can use the Set Origin command from the Cpticns menu 10 set a new 260
point for the coordinates anywhere on the decument. You'l get a dialog box thal
explaing the use of IS command,

© S8con Beaoh Soltwa, Inc. Accassory Pak 1 Faga 11




[E 11 ecigin for coortinnlen,

12 4¢1 1he arigla (0.0) for The coarcizeles 10 & pew pasiikn,
prsn eithar 3K butlen they mowa 1he cursar 1o the desired
pauition end chck 1he masse, To rasal 1he arigha to Ihe lop
T0f] coenar, fellaw tha seme sleps, bul press the ¥ teg abily
chickieg Ihe mewie, Thit dialeg wil nal appeer agsin uhen you
uee el oclg e’ IF gow eo'ect Whe midels 0K datien, ‘

Lok ] [9€- Hde tiatog e tsteve | Caneel |

Figure &: Set Origin dalog box.

After you click one of the OK buttans, yeu can click the targel cursor anywhere on
tha screan 1o maka that point the 0,0 orign. \Whan the crigin has besn sel, the
coordinates will appear as whita numbers on a bladk background. To el the origin
back 10 1he top ledt comer of the screan and document, chease Set Origin o
Commard-8 ta get the lasgat curser, and Command-click,

Menu ltems

Soie

Sove A

Save Seluclion
Revert

Dpen Starlup
Save Sterlup WY

Prist

Print Seleclion
Wigh Qualily
39% Ansuclion

Oult x0

Figuwe 7: Fia maru
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Now: Gives you an empty document named Untitled.

Open: Brings up a directory of MacPalnt documents from which you can choose. Usa
1ha Drive and Ejoct butions of tha dlaog box to find the picture you want.

Close: Closes the currently displayed cpen document, ramaving its name from the
Pictures menu.

Save: Saves an Untitled document undar a name of your cheosing. ¥ tha file was
praviously saved, the Save command wil replace the old version on disk with the
rvdsed varsion that is open,

Save As: Gives you a dialog box that will ald you in saving the currently actve
document under a new nama on 1ha disk of your choica, Use the Drive and Eject
buttons of the dalog box to change disks.

Save Selectlon: Saves whatever you've chosen with the selection rectangls as a
MacPaint document. The selecticn will bo saved in the top left comer of a new
MacPaint documaent.

Revert: Replaces the open MacPainl document with the last version saved on disk.

Open Startup: Opons a startup soroon for edithg. ¥ you requive MacPaints too's for
oditing tha startup screen, use the Save As command 1o save 1ha screen as a
MacPalnt document under a dMerem nama,

\
Save Startup: Saves the currant plcture as a Starup Scresn document.
Remember, these dosuments can't be opaned by MacPant-they can be opened by
Paint Cutter. Your startup screan must be named "StarlupScrean® without the space
batwean the words for it 1o ba displayed in place of tha regular "Welcoma ta Macintash®
startup screen,

Print: Prints a picture in a moda identical to MacPalnt's Print Draht mode as long as
High Quatty or 50% Raeduction Is not selectad (sea balaw),

Print Selection: Prinls cnly whatewer is in the saleclion reclangle.

High Quality: When this cption is chocked, you'l get high resciution prnting with
the Print and Prim Sedaction commands, High Quality prinling moda wil give you
resuits s'milar to Print Final in MacPaint.

50% Reduction: Provides half-size printing with Print and Print Selection

commands. Yeu can't have bath Hgh Quality and 507% Reduction modes in effect at
1ho same tima. This feature Is not avalable on the Laser\riter peinter.
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Quit: Retums to the Finder. If any changes have basn made Lo cpen documents,
you'll get a separate dialog box for gach cae asking whether the changes should be
saved or nol.

B—

ol L L]
Copy ts Clpbowd  NC
rarie Lo

Chear
Copg 1o Seraphosk M3

Se'wct Sereen =i
Seedct M =

-

Irwart

Fip Harlzental
ipVsricel
Rolale

Figura 6: Edit Maru

Undo: Removas the last change you made. You should role that for low memory
situatians with the 128K Mao ar tha Swilchar utlity, Urdo works in a limted way (see
Memory Configuration and Low Memory Limitations).

Cul: Ramoves e current selection from the active decument and puts it into the
Cliptourd.

Copy to Clipboard: Coples tha currant selection from the active document, wihout
clearing &, and puts il inta the Clipboard.

Paste: Pastes whataver's in the Cligboard Into 1he center of the active document. If a
salaction is active, i wil ba pasted dewn first and then the picture in the Cipboard wil
be sized 1o 4l the selection rectangle from the peevicus selection. Only piclures such

as those ot from MasPaint, MacDraw, MacDralt, or Paint Cutler can be pasted,

Clear: Remeoves the current selection wahout puting it into the Cipboard.

10 Scrapbook: Automaticaly pastes tha current selection directly intatha
(S::':ypbook withaut opening 1ha Scrapbook desk accessory. If the Scrapbook has
other items in it alraady, the pasted Rem wil be the last one.

Salect Screen: Salecls the entire soresn.

© Slcon Boodh Softwars, e Accaaaccy Pak 1 Pago 14

Select All: Selects tha entire 8 x 10" MacPaint document,

Invert: Makes a negalive image of your selection.

Filp Horlzontal: Flips a sefection of any size lef-to-right, giing you a mirrar image,
Flip Veriical: Fips a selecton ol any 8ize top-to-botiem.

Rotate: Rotatas your selection 90 degrees in a dlockwise diraction. The vertical

halght of your salecton can't be greater than 8 inches (the width of a MacPaint
document). Pleass see Memory Configuration and Low Memory Limlitations.

[

Show Pege %P

Hide Ceordinates
Sot drign A

viathas
Centimeters
Finols

Figure 8: Oplions Menu

Hide Menus: Hides tha menru bar drom view, This Is usetul whan you'ra prepacing a
starup screen of whan you want 10 see as much of 1ha piclure as possibla. You can
showhide the menu bar by doubla-cicking anywhere cn your decumant. To presanve
a sefaclion whie doulie-dlicking, chick inside the selestion or press tha space bar for
the hand tool and then double click,

Show Page: Shows you a reducad view of your entire 8° x 10 MacPant documant
In this moda you can drag tha viewing window 1o diffarent locations, You can alss
meve your pictura to d#erent localions by dragging culside tha doltad rectangle. Be
caretul-If you drag part of your picture ol the page and click OK, the data that was
dragged off the screan will be parmanantly lest

Show Coordinates: Displays a sot of coordirates which give the position ol the
CUrsor,

Set Origin: Sets the zevo paint of the cocedinatoes.

© 5con Basch Schwire, e Aocessory Pak 1 Page 15




Inches, Centimeters, Pixels: Set the unils of measurement of the cocrdinates
dispiay.

Help: Provides a dialog box describing some of Paint Culter's special features.

Dragon Curve
v¥ilchen Robots

Figure 10: Pictures Menu

: Tha Pictures menu displays the MacPaint documents that are currently
::e:'m.l’hwh:an be up to four do‘:u:tonu apen al one 1ima w_m\ a _51 2K Mac. To make
cne acive, choose it from this manu, Tha active documnent will be indicated by a check
mark

Using Paint Cutter with Switcher

al
Switcher is a utity program from Apple Compuler, Inc. that lets you have several
applications resident in Ihe 512K Mac's memory &t the same 1ime, Yau can then switch
from ona program to the other without having to exit a peogram, reurm o the Firder,
and cpen ancther application. Cutting and pasting between appications is quick ard
ar. ‘
“s;mw has been programmed specilically 10 work within the corsirainis ol the
Switchar. For the best results, combing it with only cna olhar program which can run
with 128K of memary allocated to it. Otherwisa you wil @nd up wah a “low memany®
ian, 4 describad below.
suu:’?:mu did nate that MacPaint works best if It Is gven 179K of memery, while Palnt

Cuttar works baest with 244K,

Memory Configuration and Low Memary Limitations

When Paint Cutler is run in & low memory emirenment, 1here ara soma resinctions
in tha way it warks, A low memory cond®on can arise in threa ways:
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1. with a 128K Mac,

2, with Swilcher assigning lass than 244K ta Paint Custer, and
3. with a RAM disk.

You can chedk tha memory enviconment by choosing About Palm Culter fram the
Apple menu. A message wil read either "Memory configuraticn; low” or "Memory
confguration: normal™ In low mamory situations, Paim Cutter wil ba restricted In the
following ways:

Open: You can have cny ona MacPaint decumant open at & tima, {¥ 344K is
afocated o Paint Cutter In the Switcher, then two documaents can be opan.)

Unda: Undo works as long as there is an aclive salection, Aftar you dick outside
tha selaction to paste it down, Undo no langer works, In this s4uation, be sure
10 Save olten and be aware hat the Revart command is avaiable 10 recaver
from mistakas,

Desk Accessorles: Vhen you hava a documeant cpen, Panl Cutler may tall you
that there Bnt ensugh memory 1o run any of your desk accasseries. To get
around this, dose the open decumant, use your desk accesseries, and than
reopen the cocumant. This will ba impariant Il you require an item from the
Sarapbook,

The Scrapbook: This desk accassory wil sometimes pardorm in unexpacted
ways. You may get dialog boxes thal tel you that the Scrapbock picture Is too
large, or that thare is no plcture or text in the Sorapbock when you kncw that
thera is. This doesnt maan that Paint Cutler lsn't working properly, To view
Scrapboak items In 1the normal way, close the open documant and salecl
Scrapbook again.

Rolate: Cnly scuare se'aclions can be rotated in low memery situations, Usge tha
Shilt kay to consiraln the selecton rectang'a to & equare or use Coordinates o
measure aut a square selastion.

Option Key Copies: You won't ba able 10 copy a selection by pressing the
Option key and dragging It If any part of the selection Is 51 teuching the pant of
1ha picture from which the saleclion eriginated. A basp will scund 1o fot you
know that copylng falled. Oplion key copying stil works # the selacllon is
maved entiraly away from the “white hole™ it laaves behind. ¥ you need 1o make
a copy whare Faint Culter dossn alow you to, maka your selection, Copy itto
Clipboard, and then Paste, A selection pasted from the Clipboard may ba
copled anywhere cn the page,

© S5oon Baach Sclhwar, nc. Actseoey Pk Paga 17




Command-Option Multiple Coples: You cant make multipla coples using
Command-Option and draggng a selecton.

Paste: Some oparalions can' be done 10 8 salaction that comes from the
Clipboard. These include Cut, Cogy to Clipboard, Copy 10 Scrapbook, Save
Seection, Print Selection, Fip Horizontal, Flip Vertcal and Rotate. Alzo, the
ceardinates can' bo dieplayed,

The Rulers Desk Accessory

The Rulars desk accassory comes on the Accassory Pak 1 digkin a separate {ila
and must be Installed into the System Fia of your MacPalnt cisk. Use the Font/DA
Maver utlity program inciuded on the dis 1o do the install. For instructions, see the

“Font/DA Mover" saction below.
The next lima you're using MacPaint with that disk, you can chocse Rulers from the

Apple menu and & digiog box will appear.

| R e LR ST

] 4 .. 8

o Phevts, . [00 ¢, RPR e

This pregram |s part of Rccessery Fok | ™from Silicen
Bench Saflware, Inc, Please ¢o not glve coples of it to
someone who has not purchased it

Thanks,

OCopyright 1985, . E. Wrench Jr - RN Rights Reserved,

\

Figura 11: Rulers dialeg box.

Clicking on the inghes, centimaters, of pixels niars will give you rulars in those units
o thrae sides of your MacPaint drawing window.

© Silcon Beach Softwace, Inc. Acoassony Pak

7
3}#
4

')

7

" & ide LAt Giosles Feal Fonisize i 2
“ antitee
O
&'
_L*.! i
Sk
== "
=18 G PO ey Iy N | Al Y
o
O Y &
(&4 3
17 goeare
e lf [ STV ;

Figure 12: MacPaint wilh Rulers.

AS you mave your cursor withia the drawing window, the rulers .
z'uo:: r:ra an toth the horizontal and the vertcal axes with active lick gayrg; :r? ?I?e‘;:r::

When you select a ruler from the dialeg box, IS places that ruler in the Ci
] you choosa Paste from the Edit menu, ygu will pas:i the rufar n the Mac%(a;ln‘:mrd.
windaw as shawn in tha llustraticn. Be caredul--since the Cligbaard can hoid only ona
itam al & time, you'll lose whataver is in the Clipboard when you use Rulers,

Yaou can use the rulars 1o help you draw cbjacts 1o gize. Tha rulers cisplay a scale
of inches In actual size. Ths means that a 2° X 3" rectangle as measured by tho Rulers
wil priimt cut as @ 2° X 3" rectangle on the Imageariter, This fealure is particulary
ugalul for theee using the Macintosh XL, MacPaint documents dent appear in the
g:reeig proparicn, making it dMcult 1o size objocts propary. Rulers won't acjust for

On a 128K Mac, when a ¢iz’og box covers 1ha rulers, e cav !
will disappaar along with the dialog box whan the dialog box Is w’lf gﬁ"ﬁrﬂf{ﬁ;ﬁ
hap:;o;;a. gho:a; Rulers from t:o Appia manu 10 get your rulars back.

U don't plan to use the Rulars leature, chooase Rulars from the n
dlick the close box. This will deactivate Rulers, On a 123K Mac, only 1hA: :‘cokr:‘n‘:r:; :?:
deactivated; 1he rulers will remain. On a 512K averything is erased,

The Rulers are funsticnal on & Macinlosh XL but one probiam exists that will ba a
nulsance. Unlike the Macintosh, the cursor on an XL is a hardware function and thus |s
nol tolaly controfable. When the Rulars are working, 1he cursor sometimas Is left
bahind on the screen. This happans the most with 1o Eraser, Stil, we fot that the
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banalits of Rulars cutweigh Ie shotcoming, 0 we dd rof pravert them from
functianing on an XL,

Screen Saver

Serean Saver will autcmatcaly blank your screan alter a gl Intarval of lime
chosen by you. The picture of a Macniosh wil Lavel arcund on tha acrean to let you
wnow that the Mac is still an. You imply click the mousa buttan 1o reaclivate the
scmg'm:o Scraen Saver is Installed on a disk, it will always work aulomatically
whanaver the Maa is started from that disk. To Install Screen Saver Into the System s
ol & disk. move the Screon Saver Instal file 1o the disk you want to inslal it on,
Doubla-dick the Screen Saver lastal Icon 1o get the dalog box shoan balow, Use the
ceroll box 10 choose the Ilma interval. The tme urit defaults 1o 10 minutes. ¥ you press
Option whila dragging, the 1ime unil wil be saccnds. {The can be usedul for
gamansiraling quickly how Scraan Saver works.) Prass the Install bution to instal
Serpan Saver o your Syste tia, Once you have done 1his, Screen Saver wil be
active whenavee you start the Mac with that disk. You only need to do this 10 a disk
onca, From ten on, Scresn Saver wil work until yeu choose lo remave it. After the
installation is camplete, you can frash the Screen Saver Install program. Il you want to
ramave 1ha utiity at a later time, you wil have 1o mave the Inztall program erdo the disk

onoe again.

from $tican Beach Soflwers, Inc.

paxl  Stertup Disk
screen Saver Nol Inclalied

il

streen Sever 017
CCapyr V. | 905 1. Wrwwh = 48 Figls Faperved J

Figure 13: Screen Saver clalog box.
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To ramove Screen Saver from your System flo, open Screen Saver Install and gick
1ha Remove button. This will hava no effect untl the Mac is reslarted. Then click tha
Quit bution to return ta the desktop. Finally, restant your Mac {use Shusdown H you
have Findor 4,1) to purge Screen Saver from the computer's memery,

To change the delay interval, opan Screen Saver Install, st your interval, cick
Change Delay, and choose Quit. If you skip the step of cicking on Changa Delay, 1he
new delay will be in effect only until you fum off your Macintosh,

Please note that Screen Saver may not be compatible wilth altered System files
such as these provided wieh hard disk drives. Test Sarean Saver only after backing up
your disks and hard disk slartup voluma.,

MacPaint will, &1 limas, held your last change in temporary buters, \Whan Screen
Saver blans the screen, thess buffars are lost, You'll sea tha efects of this when
Screen Saver blanks the screon whia you're aditing a pattern. 'When you rétum to
your scraen, parts af the odi pattern window will be missing. Click the OK buticn and
chease edit pattern again, Also, when you raturn from a black scraen, your last
change wil ba undana, You can avod this by clicking anywhera on your piclura
befora you leave your Mac unattanded.

You should note that with many peograms, Screan Saver wil Interrupt 1ha printing
of documents. With telecommunicatons programs, the transfer of fles may ba halted,
To rasuma, just dick the mouse button, To 1est programs for 1ls, use 1ha Option
featura while installing Screan Saver 1o a short tmae intanval guch as 30 seconds, Now
Iry printing a document or making a file transfer. If interruption accurs, you may wan 1o
remeove Screan Saver from 1hase disks.

The QuickEject Desk Accessory

This desk accasaory will eject all Noppy disks and restart tha Macintosh, Use the
ForDA Mover utlity program included cn the Paint Cutter dizk 10 Install QuickEject on
ary disk that has a system file on it (a startup disk).

Daon't forgat that H you havent saved your document(s), they will ba parmanenily
lost It QuickEjact Is used.

CuickEjact will not update 1ha daskiop if used fram the Findar, This means that any
changes you made 10 the windows or folders of the ciskettes will not ba recordad
bedoro tha ejoct oocours. Whan working from the Finder, use the Shul Down feature
{rom the Spedial menu of Findar 4.1 10 have the desktop updated. QuickEjedt is
designed for use lrom wilhin programs. Used in this way, & will update the deskiop
bedove it ejects the disks.,
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The Coordinates Desk Accessory

Uza the Font/'DA Mover ullity peogram included on the disk (see insiructions
balow) 10 instal Cocrdinates on any dak that has a system 1lie on It {a startup disk),
Onco instaled, when yeu chooza Cocrdnates Irem the Appla meny a dlaiog bax

wil appear.

entimeters
Inches
Pixels
OFF

[ ©1985 EWrench

Figure 14; Coordinates dalog box.

You can choaso unis of inches, cenlimaters, or pixels, or you can choosa 10 turn
the feature ofl. Ay 1ima the Coordinates dialeg box is displayed on tha acreen, the
arigin {0,0) can ba sat by maving the cursor 1o the desired position and pressing the

Space bar.

Silicon Beach Fon!

Uga FortDA Movar 1o move $his new feal availabie, in 12- and 24-point sizas, Into
tha System e of thase disks that aliow you 1o change fonls. Sea the instruclions
balow. Here's & sample of the font:

abcdefghlJkimnopqr stuvwxyz
ABCODEFGHIJKLMNOPQASTUVWXY Z
123456768%90-=[1\;",../

|@eg &0+ 1707

e 1298 )

Figure 15: Slicon Baach Fort in 12-poinl.
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To get the spacial characters, use 1ha lolowing keystokas:

™ - Option 2
& - Option A
@ - Optign G
« = _Dptlon \
» - Shift Option \

® - Shift Option Z
@ - Shift Option

Figure 16: The special characters,

Fonl/DA Mover

The Font/DA Maver program has been made available by Apple Computer, Inc.
will lot you mova fonts and dask accassees in and cul of your System files. Kaep in
mind that there are two Kimilations to adding fonts and dask accassories. Firsl, ¥ you're
using & Mac with tioppy drives, tha System fia can gel 5o large thal it will take up all of
tha gisk paca, leaving ro raom for ather tites, Secondly, you can add so mary of
tham that the manu will be 5o lang that the botlom Ilems went be vishla,

Tao use tha Fort DA Mover program, nsen the Paint Culter disk and double-click
the FanyDA Movar lcon 10 get tha dialog bex shown i tha ilusiration,

Moving Fonls

When tha program stans, it dafaulls to tha Foals option and automalically opens the
System file of tha stantup disk, displaying all the fonts stored thera, Click tha ooen
button an the other side ard irsert a disk that you want 10 exchange forts wish. Whan
you get tha direciory, double-cick System 1o apan 1ha System fia of the second dak.
Choosa the font you wanl 1o mave ard click Copy.
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Flgura 17: Moving a Far.

Alter a fow moaments, the loot will appear In the directory of lonts of the receiving
System e,

On a 120K Magc, there i3 a Naw (better known as a *bug®) in the FarwDA Mover-- it
doasn't wark peoperly wiah large foris. Tha o'd Fent Maver dees funclicn properly and
i2 algo included on the disk for thess who have 126K Macs, Il you ara Instaling both
12- and 24-point Sticon Baach fants, 1he Fonl'DA Movar can ba used If you select both
ard do the copy inone step. To Install just the 24-peint fonl on a 128X Mac, you will
have 10 use tha o'd Foal Mover program

Maoving Desk Accessories

After slartng the FortDA Mover pregram, click the Dask Accasseries bution 1o stant
the Dask Accessory Maver, The desk accessories in the System llle of the starlup dsk
{and tha system fila ol a second ciskeste in the secord deive i you have ona) will be
dizplayad, Click 1ha one you want 10 remave or copy and use the Remave and Copy
butions. To get a desk accessory from anather dsk, dick the Clesa button fer the disk
you ra leager nead and then click tha Cpen tutton. From the dialeg box, cheosa ejact
and insert the new digkette, Double-gick either the System e or an individual desk
accassory file name 10 opan t, Now you can capy of ramove il
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Figura 18: Moving & Dask Accessory,

Crealing Desk Accessory Files

o To create a fila that containg individual or groups of desk accessores, click the
50 Dution for the extarmal drive, and choosa New from the dialog box. N
lile and click 1ha Craate button, ¥ st o

®Fort
Coeak Recarnarny MV

B C_ory )|

New Fost Fils Namey l Slesiuy

[t | m
(Gasy  (Ewn) | ()

225K tren
Ueie

Figure 19: Creating a new dask accessory file.
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NowyoucanmnomocmommkaoousommwsmobyuMaduk

F00088 anddlc)dngoopy.Thonooldookacemodamlbomdondlskunar
monat:zywau\om Tha icon of 1ha file will be a sulcase.

Choase Quit 10 axll the Fort/DA Mover program,
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Appendix: Error Messages

@ Rmamary problem exiele.

Pare Is Insuificient menory aveiledle
e ren Peint Culler, Pleate suw the
Rapentin of 1he user menusl,

=)

Insutficient Memory
Thara are three causes for this error:

+ gz than 121K of memaery has bean allocated 1o Pairt Cutter in Switchar,
* Il a large RAMdisk has baen inslaled,

* Il a desk aocessory is taking up some of tha memory naadad on a 128K
Mac,

Tha solution for the fest twe situations is siraightforward--allocate the appropriate
amounts of mamory. Fer the last situation, try using the orignal System file that comes
on the Acocessory Pak 1 disk.

E Usatin 10 print,

There s o0 prablem with pour printer criver,
Poance sea the Appentin of tho user manuel,

()

Unable to Print

There are two ways that 1lvs can happen. First, if a pra-May '85 System file is being
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used. The seluton & 10 updats It with tha Update program that Applo sont 1o dealers.
Secard, if a post-May "85 System file is baing used and thara's no Imageariter fle on
1ha disk. Tha solution is 10 copy a peet-May '85 Imagewritar 1ie onlo the disk

@ The Clipbeard will be eresed.

The Clipboard das beea damaged,
possitly by the Seraphoot. Flaase
102 the Appeadin af the user manval,

Clipboard Erased

The Cipboard e is stored on the disk. If you iy 1o copy somelhing from 1ha
Soapbook (1o the Clpboard) and there is net encugh room ca the dak 1he copy lals
and there is NO error messaga from tha Scrapboak dask accessery. The Clipboard
e s damaged ard this is what is being reperied to you, The soluticn is to free up
soma dsk space by deleting uaneeded filas and iry again,
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